The Altera Virtual JTAG (altera_virtual_jtag) megafunction IP core provides access to the PLD source through the JTAG interface. This IP core is optimized for Altera device architectures. Using IP cores in place of coding your own logic saves valuable design time, and offers more efficient logic synthesis and device implementation. You can scale the IP core’s size by setting parameters.

Related Information
Introduction to Altera IP Cores

Introduction

The Virtual JTAG IP core allows you to create your own software solution for monitoring, updating, and debugging designs through the JTAG port without using I/O pins on the device, and is one feature in the On-Chip Debugging Tool Suite. The Quartus® II software or JTAG control host identifies each instance of this IP core by a unique index. Each IP core instance functions in a flow that resembles the JTAG operation of a device. The logic that uses this interface must maintain the continuity of the JTAG chain on behalf the PLD device when this instance becomes active.

With the Virtual JTAG IP core you can build your design for efficient, fast, and productive debugging solutions. Debugging solutions can be part of an evaluation test where you use other logic analyzers to debug your design, or as part of a production test where you do not have a host running an embedded logic analyzer. In addition to debugging features, you can use the Virtual JTAG IP core to provide a single channel or multiple serial channels through the JTAG port of the device. You can use serial channels in applications to capture data or to force data to various parts of your logic.

Each feature in the On-Chip Debugging Tool Suite leverages on-chip resources to achieve real time visibility to the logic under test. During runtime, each tool shares the JTAG connection to transmit collected test data to the Quartus II software for analysis. The tool set consists of a set of GUIs, IP core intellectual property (IP) cores, and Tcl application programming interfaces (APIs). The GUIs provide the configuration of test signals and the visualization of data captured during debugging. The Tcl scripting interface provides automation during runtime.

The Virtual JTAG IP core provides you direct access to the JTAG control signals routed to the FPGA core logic, which gives you a fine granularity of control over the JTAG resource and opens up the JTAG resource as a general-purpose serial communication interface. A complete Tcl API is available for sending and receiving transactions into your device during runtime. Because the JTAG pins are readily accessible during runtime, this IP core enables an easy way to customize a JTAG scan chain internal to the device, which you can then use to create debugging applications.
Examples of debugging applications include induced trigger conditions evaluated by a SignalTap® II Logic Analyzer by exercising test signals connected to the analyzer instance, a replacement for a front panel interface during the prototyping phase of the design, or inserted test vectors for exercising the design under test.

The infrastructure is an extension of the JTAG protocol for use with Altera-specific applications and user applications, such as the SignalTap II Logic Analyzer.

Installing and Licensing IP Cores

The Quartus II software includes the Altera IP Library. The library provides many useful IP core functions for production use without additional license. You can fully evaluate any licensed Altera IP core in simulation and in hardware until you are satisfied with its functionality and performance. Some Altera IP cores, such as MegaCore® functions, require that you purchase a separate license for production use. After you purchase a license, visit the Self Service Licensing Center to obtain a license number for any Altera product.

Figure 1: IP Core Installation Path

Note: The default IP installation directory on Windows is <drive>\altera\<version number>; on Linux it is <home directory>/altera/<version number>.

Related Information
- Altera Licensing Site
- Altera Software Installation and Licensing Manual

Upgrading Outdated IP Cores

Each IP core has a release version number that corresponds to its Quartus II software release. When you include IP cores from a previous version of the Quartus II software in your project, click Project > Upgrade IP Components to identify and upgrade any outdated IP cores.

The Quartus II software prompts you to upgrade an IP core when the latest version includes port, parameter, or feature changes. The Quartus II software also notifies you when IP cores are unsupported or cannot upgrade in the current version of the Quartus II software. Most Altera IP cores support automatic simultaneous upgrade, as indicated in the Upgrade IP Components dialog box. IP cores unsupported by auto-upgrade may require regeneration in the parameter editor, as indicated in the Upgrade IP Components dialog box.

Before you begin

Upgrading IP cores changes your original design files. If you have not already preserved your original source files, click Project > Archive Project and save the project archive.
1. In the latest version of the Quartus II software, open the Quartus II project containing an outdated IP core variation.

   **Note:** File paths in a restored project archive must be relative to the project directory and you must reference the IP variation .v or .vhd file or .qsys file, not the .qip file.

2. Click **Project > Upgrade IP Components**. The **Upgrade IP Components** dialog box displays all outdated IP cores in your project, along with basic instructions for upgrading each core.

3. To simultaneously upgrade all IP cores that support automatic upgrade, click **Perform Automatic Upgrade**. The IP variation upgrades to the latest version.

4. To upgrade IP cores unsupported by automatic upgrade, follow these steps:
   a. Select the IP core in the **Upgrade IP Components** dialog box.
   b. Click **Upgrade in Editor**. The parameter editor appears.
   c. Click **Finish** or **Generate** to regenerate the IP variation and complete the upgrade. The version number updates when complete.

   **Note:** Example designs provided with any Altera IP core regenerate automatically whenever you upgrade the IP core in the **Upgrade IP Components** dialog box.

---

**Figure 2: Upgrading Outdated IP Cores**

---

**Example 1: Upgrading IP Cores at the Command Line**

Alternatively, you can upgrade IP cores at the command line. To upgrade a single IP core, type the following command:

```
quartus_sh --ip_upgrade -variation_files <my_ip_path> <project>
```
To upgrade a list of IP cores, type the following command:

```
quartus_sh --ip_upgrade -variation_files
"<my_ip>.qsys;<my_ip>.<hdl>; <project>"
```

**Note:** IP cores older than Quartus II software version 12.0 do not support upgrade. Altera verifies that the current version of the Quartus II software compiles the previous version of each IP core. The *MegaCore IP Library Release Notes* reports any verification exceptions for MegaCore IP. The *Quartus II Software and Device Support Release Notes* reports any verification exceptions for other IP cores. Altera does not verify compilation for IP cores older than the previous two releases.

**Related Information**

- *MegaCore IP Library Release Notes*
- *Quartus II Software and Device Support Release Notes*

### On-Chip Debugging Tool Suite

The On-Chip Debugging Tool Suite enables real time verification of a design and includes the following tools:

**Table 1: On-Chip Debugging Tool Suite**

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
<th>Typical Circumstances for Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SignalTap II Logic Analyzer</strong></td>
<td>Uses FPGA resources to sample tests nodes and outputs the information to the Quartus II software for display and analysis.</td>
<td>You have spare on-chip memory and want functional verification of your design running in hardware.</td>
</tr>
<tr>
<td><strong>SignalProbe</strong></td>
<td>Incrementally routes internal signals to I/O pins while preserving the results from your last place-and-route.</td>
<td>You have spare I/O pins and want to check the operation of a small set of control pins using either an external logic analyzer or an oscilloscope.</td>
</tr>
<tr>
<td><strong>Logic Analyzer Interface (LAI)</strong></td>
<td>Multiplexes a larger set of signals to a smaller number of spare I/O pins. LAI allows you to select which signals are switched onto the I/O pins over a JTAG connection.</td>
<td>You have limited on-chip memory and have a large set of internal data buses that you want to verify using an external logic analyzer. Logic analyzer vendors, such as Tektronics and Agilent, provide integration with the tool to improve usability.</td>
</tr>
<tr>
<td><strong>In-System Memory Content Editor</strong></td>
<td>Displays and allows you to edit on-chip memory.</td>
<td>You want to view and edit the contents of either the instruction cache or data cache of a Nios® II processor application.</td>
</tr>
</tbody>
</table>
Applications of the Virtual JTAG IP Core

You can instantiate single or multiple instances of the Virtual JTAG IP core in your HDL code. During synthesis, the Quartus II software assigns unique IDs to each instance, so that each instance is accessed individually. You can instantiate up to 128 instances of the Virtual JTAG IP core. The figure below shows a typical application in a design with multiple instances of the IP core.

Figure 3: Application Example

The hub automatically arbitrates between multiple applications that share a single JTAG resource. Therefore, you can use the IP core in tandem with other on-chip debugging applications, such as the SignalTap II Logic Analyzer, to increase debugging visibility. You can also use the IP core to provide simple stimulus patterns to solicit a response from the design under test during run-time, including the following applications:

- To diagnose, sample, and update the values of internal parts of your logic. With this IP core, you can easily sample and update the values of the internal counters and state machines in your hardware device.
- To build your own custom software debugging IP using the Tcl commands to debug your hardware. This IP communicates with the instances of the Virtual JTAG IP core inside your design.
- To construct your design to achieve virtual inputs and outputs.
If you are building a debugging solution for a system in which a microprocessor controls the JTAG chain, you cannot use the SignalTap II Logic Analyzer because the JTAG control must be with the microprocessor. You can use low-level controls for the JTAG port from the Tcl commands to direct microprocessors to communicate with the Virtual JTAG IP core inside the device core.

**JTAG Protocol**

The original intent of the JTAG protocol (standardized as IEEE 1149.1) was to simplify PCB interconnectivity testing during the manufacturing stage. As access to integrated circuit (IC) pins became more limited due to tighter lead spacing and FPGA packages, testing through traditional probing techniques, such as “bed-of-nails” test fixtures, became infeasible. The JTAG protocol alleviates the need for physical access to IC pins via a shift register chain placed near the I/O ring. This set of registers near the I/O ring, also known as boundary scan cells (BSCs), samples and forces values out onto the I/O pins. The BSCs from JTAG-compliant ICs are daisy-chained into a serial-shift chain and driven via a serial interface.

During boundary scan testing, software shifts out test data over the serial interface to the BSCs of select ICs. This test data forces a known pattern to the pins connected to the affected BSCs. If the adjacent IC at the other end of the PCB trace is JTAG-compliant, the BSC of the adjacent IC samples the test pattern and feeds the BSCs back to the software for analysis. The figure below illustrates the boundary-scan testing concept.

**Figure 4: IEEE Std. 1149.1 Boundary-Scan Testing**

Because the JTAG interface shifts in any information to the device, leaves a low footprint, and is available on all Altera devices, it is considered a general purpose communication interface. In addition to boundary scan applications, Altera devices use the JTAG port for other applications, such as device configuration and on-chip debugging features available in the Quartus II software.

**Related Information**

IEEE 1149.1 JTAG Boundary-Scan Testing

**JTAG Circuitry Architecture**

The basic architecture of the JTAG circuitry consists of the following components:

- A set of Data Registers (DRs)
- An Instruction Register (IR)
- A state machine to arbitrate data (known as the Test Access Port (TAP) controller)
A four- or five-pin serial interface, consisting of the following pins:

- Test data in (T\text{DI}), used to shift data into the IR and DR shift register chains
- Test data out (T\text{DO}), used to shift data out of the IR and DR shift register chains
- Test mode select (T\text{MS}), used as an input into the TAP controller
- T\text{CK}, used as the clock source for the JTAG circuitry
- TR\text{ST} resets the TAP controller. This is an optional input pin defined by the 1149.1 standard.

Note: The TR\text{ST} pin is not present in the Cyclone device family.

The bank of DRs is the primary data path of the JTAG circuitry. It carries the payload data for all JTAG transactions. Each DR chain is dedicated to serving a specific function. Boundary scan cells form the primary DR chain. The other DR chains are used for identification, bypassing the IC during boundary scan tests, or a custom set of register chains with functions defined by the IC vendor. Altera uses two of the DR chains with user-defined IP that requires the JTAG chain as a communication resource, such as the on-chip debugging applications. The Virtual JTAG IP core, in particular, allows you to extend the two DR chains to a user-defined custom application.

You use the instruction register to select the bank of Data Registers to which the T\text{DI} and T\text{DO} must connect. It functions as an address register for the bank of Data Registers. Each IR instruction maps to a specific DR chain.

All shift registers that are a part of the JTAG circuitry (IR and DR register chains) are composed of two kinds of registers: shift registers, which capture new serial shift input from the T\text{DI} pin, and parallel hold registers, which connect to each shift register to hold the current input in place when shifting. The parallel hold registers ensure stability in the output when new data is shifted.

The figure below shows a functional model of the JTAG circuitry. The TR\text{ST} pin is an optional pin in the 1149.1 standard and not available in Cyclone devices. The TAP controller is a hard controller; it is not created using programmable resources. The major function of the TAP controller is to route test data between the IR and DR register chains.
System-Level Debugging Infrastructure

On-chip debugging tools that require the JTAG resources share two Data Register chain paths; \texttt{USER1} and \texttt{USER0} instructions select the Data Register chain paths. The datapaths are an extension of the JTAG circuitry for use with the programmable logic elements in Altera devices.

Because the JTAG resource is shared among multiple on-chip applications, an arbitration scheme must define how the \texttt{USER0} and \texttt{USER1} scan chains are allocated between the different applications. The system-level debugging (SLD) infrastructure defines the signaling convention and the arbitration logic for all programmable logic applications using a JTAG resource. The figure below shows the SLD infrastructure architecture.
Transaction Model of the SLD Infrastructure

In the presence of an application that requires the JTAG resource, the Quartus II software automatically implements the SLD infrastructure to handle the arbitration of the JTAG resource. The communication interface between JTAG and any IP cores is transparent to the designer. All components of the SLD infrastructure, except for the JTAG TAP controller, are built using programmable logic resources.

The SLD infrastructure mimics the IR/DR paradigm defined by the JTAG protocol. Each application implements an Instruction Register, and a set of Data Registers that operate similarly to the Instruction Register and Data Registers in the JTAG standard. Note that the Instruction Register and the Data Register banks implemented by each application are a subset of the USER1 and USER0 Data Register chains. The SLD infrastructure consists of three subsystems: the JTAG TAP controller, the SLD hub, and the SLD nodes.

The SLD hub acts as the arbiter that routes the TDI pin connection between each SLD node, and is a state machine that mirrors the JTAG TAP controller state machine.

The SLD nodes represent the communication channels for the end applications. Each instance of IP requiring a JTAG communication resource, such as the SignalTap II Logic Analyzer, would have its own communication channel in the form of a SLD node interface to the SLD hub. Each SLD node instance has its own Instruction Register and bank of DR chains. Up to 255 SLD nodes can be instantiated, depending on resources available in your device.

Together, the sld_hub and the SLD nodes form a virtual JTAG scan chain within the JTAG protocol. It is virtual in the sense that both the Instruction Register and DR transactions for each SLD node instance are encapsulated within a standard DR scan shift of the JTAG protocol.

The Instruction Register and Data Registers for the SLD nodes are a subset of the USER1 and USER0 Data Registers. Because the SLD Node IR/DR register set is not directly part of the IR/DR register set of the JTAG protocol, the SLD node Instruction Register and Data Register chains are known as Virtual IR (VIR) and Virtual DR (VDR) chains. The figure below shows the transaction model of the SLD infrastructure.
SLD Hub Finite State Machine

The SLD hub decodes TMS independently from the hard JTAG TAP controller state machine and implements an equivalent state machine (called the “SLD hub finite state machine”) for the internal JTAG path. The SLD hub performs a similar function for the VIR and VDR chains that the TAP controller performs for the JTAG IR and DR chains. It enables an SLD node as the active path for the TDI pin, selects the TDI data between the VIR and VDR registers, controls the start and stop of any shift transactions, and controls the data flow between the parallel hold registers and the parallel shift registers of the VIR and VDR.

Because all shifts to VIR and VDR are encapsulated within a DR shift transaction, an additional control signal is necessary to select between the VIR and VDR data paths. The SLD hub uses the USER1 command to select the VIR data path and the USER0 command to select the VDR data path.
This state information, including a bank of enable signals, is forwarded to each of the SLD nodes. The SLD nodes perform the updates to the VIR and VDR according to the control states provided by the sld_hub. The SLD nodes are responsible for maintaining continuity between the TDI and TDO pins.

The figure below shows the SLD hub finite state machine. There is no direct state signal available to use for application design.

**Figure 8: sld_hub Finite State Machine**

---

**Virtual JTAG Interface Description**

The Virtual JTAG Interface implements an SLD node interface, which provides a communication interface to the JTAG port. The IP core exposes control signals that are part of the SLD hub; namely, JTAG port signals, all finite state machine controller states of the TAP controller, and the SLD hub finite state machine. Additionally, each instance of the Virtual JTAG IP cores contain the virtual Instruction Register for the SLD node. Instantiation of this IP core automatically infers the SLD infrastructure, and one SLD node is added for each instantiation.

The Virtual JTAG IP core provides a port interface that mirrors the actual JTAG ports. The interface contains the JTAG port pins, a one-hot decoded output of all JTAG states, and a one-hot decoded output of all the virtual JTAG states. Virtual JTAG states are the states decoded from the SLD hub finite state machine. The ir_in and ir_out ports are the parallel input and output to and from the VIR. The VIR ports are used to select the active VDR datapath. The JTAG states and TMS output ports are provided for debugging purposes only. Only the virtual JTAG, TDI, TDO, and the IR signals are functional elements of the IP core. When configuring this IP core using the parameter editor, you can hide TMS and the decoded JTAG states.
The figure below shows the input and output ports of the virtual JTAG IP core. The JTAG TAP controller outputs and TMS signals are used for informational purposes only. These signals can be exposed using the Create primitive JTAG state signal ports option in the parameter editor.

**Figure 9: Input and Output Ports of the Virtual JTAG IP Core**

### Input Ports

**Table 2: Input Ports for the Virtual JTAG IP Core**

<table>
<thead>
<tr>
<th>Port name</th>
<th>Required</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>tdo</td>
<td>Yes</td>
<td>Writes to the TDO pin on the device.</td>
<td></td>
</tr>
<tr>
<td>ir_out[]</td>
<td>No</td>
<td>Virtual JTAG instruction register output. The value is captured whenever virtual_state_cir is high.</td>
<td>Input port [SLD_IR_WIDTH−1..0] wide. Specify the width of this bus with the SLD_IR_WIDTH parameter.</td>
</tr>
</tbody>
</table>
### Output Ports

Table 3: Output Ports for the Virtual JTAG IP Core

<table>
<thead>
<tr>
<th>Port Name</th>
<th>Required</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>tck</td>
<td>Yes</td>
<td>JTAG test clock.</td>
<td>Connected directly to the TCK device pin. Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>tdi</td>
<td>Yes</td>
<td>TDI input data on the device. Used when <code>virtual_state_sdr</code> is high.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>ir_in[]</td>
<td>No</td>
<td>Virtual JTAG instruction register data. The value is available and latched when <code>virtual_state_uir</code> is high.</td>
<td>Output port <code>[SLD_IR_WIDTH-1..0]</code> wide. Specify the width of this bus with the <code>SLD_IR_WIDTH</code> parameter.</td>
</tr>
</tbody>
</table>

Table 4: High-Level Virtual JTAG State Signals

<table>
<thead>
<tr>
<th>Port Name</th>
<th>Required</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>virtual_state_cdr</td>
<td>No</td>
<td>Indicates that virtual JTAG is in Capture_DR state.</td>
<td></td>
</tr>
<tr>
<td>virtual_state_sdr</td>
<td>Yes</td>
<td>Indicates that virtual JTAG is in Shift_DR state.</td>
<td>In this state, this instance is required to establish the JTAG chain for this device.</td>
</tr>
<tr>
<td>virtual_state_e1dr</td>
<td>No</td>
<td>Indicates that virtual JTAG is in Exit1_DR state.</td>
<td></td>
</tr>
<tr>
<td>virtual_state_pdr</td>
<td>No</td>
<td>Indicates that virtual JTAG is in Pause_DR state.</td>
<td>The Quartus II software does not cycle through this state using the Tcl command.</td>
</tr>
<tr>
<td>virtual_state_e2dr</td>
<td>No</td>
<td>Indicates that virtual JTAG is in Exit2_DR state.</td>
<td>The Quartus II software does not cycle through this state using the Tcl command.</td>
</tr>
<tr>
<td>virtual_state_u1dr</td>
<td>No</td>
<td>Indicates that virtual JTAG is in Update_DR state.</td>
<td></td>
</tr>
<tr>
<td>virtual_state_cir</td>
<td>No</td>
<td>Indicates that virtual JTAG is in Capture_IR state.</td>
<td></td>
</tr>
<tr>
<td>virtual_state_uir</td>
<td>No</td>
<td>Indicates that virtual JTAG is in Update_IR state.</td>
<td></td>
</tr>
</tbody>
</table>
## Table 5: Low-Level Virtual JTAG State Signals

<table>
<thead>
<tr>
<th>Port Name</th>
<th>Required</th>
<th>Description</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>jtag_state_tlr</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Test_Logic_Reset state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_rti</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Run_Test/Idle state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_sdrs</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Select_DR_Scan state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_cdr</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Capture_DR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_sdr</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Shift_DR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_e1dr</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Exit1_DR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_pdr</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Pause_DR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_e2dr</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Exit2_DR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_udr</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Update_DR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_sirs</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Select_IR_Scan state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_cir</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Capture_IR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_sir</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Shift_IR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>Port Name</td>
<td>Required</td>
<td>Description</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------</td>
<td>----------------------------------------------------------------------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>jtag_state_elir</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Exit1_IR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_pir</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Pause_IR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_e2ir</td>
<td>No</td>
<td>Indicates that the device JTAG controller is in the Exit2_IR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>jtag_state_uir</td>
<td></td>
<td>Indicates that the device JTAG controller is in the Update_IR state.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
<tr>
<td>tms</td>
<td></td>
<td>TMS input pin on the device.</td>
<td>Shared among all virtual JTAG instances.</td>
</tr>
</tbody>
</table>

**Parameters**

**Table 6: Virtual JTAG Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLD_AUTO_INSTANCE_INDEX</td>
<td>String</td>
<td>Yes</td>
<td>Specifies whether the Compiler automatically assigns an index to the Virtual JTAG instance. Values are YES or NO. When you specify NO, you can find the auto assigned value of INSTANCE_ID in the quartus_map file. When you specify NO, you must define INSTANCE_INDEX. If the index specified is not unique in a design, the Compiler automatically reassigns an index to the instance. The default value is YES.</td>
</tr>
<tr>
<td>SLD_INSTANCE_INDEX</td>
<td>Integer</td>
<td>No</td>
<td>Specifies a unique identifier for every instance of alt_virtual_jtag when AUTO_INSTANCE_ID is specified to YES. Otherwise, this value is ignored.</td>
</tr>
<tr>
<td>SLD_IR_WIDTH</td>
<td>Integer</td>
<td>Yes</td>
<td>Specifies the width of the instruction register ir_in[] of this virtual JTAG between 1 and 24. If omitted, the default is 1.</td>
</tr>
</tbody>
</table>
Design Flow of the Virtual JTAG IP Core

Designing with the Virtual JTAG IP core includes the following processes:

- Configuring the Virtual JTAG IP core with the desired Instruction Register length and instantiating the IP core.
- Building the glue logic for interfacing with your application.
- Communicating with the Virtual JTAG instance during runtime.

In addition to the JTAG datapath and control signals, the Virtual JTAG IP core encompasses the VIR. The Instruction Register size is configured in the parameter editor. The Instruction Register port on the Virtual JTAG IP core is the parallel output of the VIR. Any updated VIR information can be read from this port after the virtual_state_uir signal is asserted.

After instantiating the IP core, you must create the VDR chains that interface with your application. To do this, you use the virtual instruction output to determine which VDR chain is the active datapath, and then create the following:

- Decode logic for the VIR
- VDR chains to which each VIR maps
- Interface logic between your VDR chains and your application logic

Your glue logic uses the decoded one-hot outputs from the IP core to determine when to shift and when to update the VDR. Your application logic interfaces with the VDR chains during any one of the non-shift virtual JTAG states.

For example, your application logic can parallel read an updated value that was shifted in from the JTAG port after the virtual_state_uir signal is asserted. If you load a value to be shifted out of the JTAG port, you would do so when the virtual_state_cdr signal is asserted. Finally, if you enable the shift register to clock out information to TDO, you would do so during the assertion of virtual_state_sdr.

Maintaining TDI-to-TDO connectivity is important. Ensure that all possible instruction codes map to an active register chain to maintain connectivity in the TDI-to-TDO datapath. Altera recommends including a bypass register as the active register for all unmapped IR values.

Note that TCK (a maximum 10-MHz clock, if using an Altera programming cable) provides the clock for the entire SLD infrastructure. Be sure to follow best practices for proper clock domain crossing between the JTAG clock domain and the rest of your application logic to avoid metastability issues. The decoded virtual JTAG state signals can help determine a stable output in the VIR and VDR chains.

After compiling and downloading your design into the device, you can perform shift operations directly to the VIR and VDR chains using the Tcl commands from the quartus_stp executable and an Altera programming cable (for example, a USB-Blaster™, a MasterBlaster™, or a ByteBlaster™ II cable). The quartus_stp executable is a command-line executable that contains Tcl commands for all on-chip debug features available in the Quartus II software.

The figure below shows the components of a design containing one instance of the Virtual JTAG IP core. The TDI-to-TDO datapath for the virtual JTAG chain, shown in red, consists of a bank of DR registers. Input to the application logic is the parallel output of the VDR chains. Decoded state signals are used to signal start and stop of shift transactions and signals when the VDR output is ready.

The IR_out port, not shown, is an optional input port you can use to parallel load the VIR from the FPGA core logic.
Simulation Model

The virtual JTAG IP core contains a functional simulation model that provides stimuli that mimic VIR and VDR shifts. You can configure the stimuli using the parameter editor. You can use this simulation model for functional verification only, and the operation of the SLD hub and the SLD node-to-hub interface is not provided in this simulation model.

Run-Time Communication

The Tcl API for the Virtual JTAG IP core consists of a set of commands for accessing the VIR and VDR of each virtual JTAG instance.

These commands contain the underlying drivers for accessing an Altera programming cable and for issuing shift transactions to each VIR and VDR. The table below provides the Tcl commands in the `quartus_stp` executable that you can use with the Virtual JTAG IP core, and are intended for designs that use a custom controller to drive the JTAG chain.

Each instantiation of the Virtual JTAG IP core includes an instance index. All instances are sequentially numbered and are automatically provided by the Quartus II software. The instance index starts at instance index 0. The VIR and VDR shift commands described in the table decode the instance index and provide an address to the SLD hub for each IP core instance. You can override the default index provided by the Quartus II software during configuration of the IP core.

The table below provides the Tcl commands in the `quartus_stp` executable that you can use with the Virtual JTAG IP core, and are intended for designs that use a custom controller to drive the JTAG chain.
<table>
<thead>
<tr>
<th>Command</th>
<th>Arguments</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device virtual ir shift</td>
<td><code>-instance_index &lt;instance_index&gt;</code></td>
<td>Perform an IR shift operation to the virtual JTAG instance specified by the <code>instance_index</code>. Note that <code>ir_value</code> takes a numerical argument.</td>
</tr>
<tr>
<td></td>
<td><code>-ir_value &lt;numeric_ir_value&gt;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>-no_captured_ir_value</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>-show_equivalent_device_ir_dr_shift</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(1)</td>
<td></td>
</tr>
<tr>
<td>Device virtual dr shift</td>
<td><code>-instance_index &lt;instance_index&gt;</code></td>
<td>Perform a DR shift operation to the virtual JTAG instance.</td>
</tr>
<tr>
<td></td>
<td><code>-dr_value &lt;dr_value&gt;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>-length &lt;data_register_length&gt;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>-no_captured_dr_value</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>-show_equivalent_device_ir_dr_shift</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>-value_in_hex</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(1)</td>
<td></td>
</tr>
<tr>
<td>Get hardware names</td>
<td>NONE</td>
<td>Queries for all available programming cables.</td>
</tr>
<tr>
<td>Open device</td>
<td><code>-device_name &lt;device_name&gt;</code></td>
<td>Selects the active device on the JTAG chain.</td>
</tr>
<tr>
<td></td>
<td><code>-hardware_name &lt;hardware_name&gt;</code></td>
<td></td>
</tr>
<tr>
<td>Close device</td>
<td>NONE</td>
<td>Ends communication with the active JTAG device.</td>
</tr>
<tr>
<td>Device lock</td>
<td><code>-timeout &lt;timeout&gt;</code></td>
<td>Obtains exclusive communication to the JTAG chain.</td>
</tr>
<tr>
<td>Device unlock</td>
<td>NONE</td>
<td>Releases <code>device_lock</code>.</td>
</tr>
<tr>
<td>Device ir shift</td>
<td><code>-ir_value &lt;ir_value&gt;</code></td>
<td>Performs a IR shift operation.</td>
</tr>
<tr>
<td></td>
<td><code>-no_captured_ir_value</code></td>
<td></td>
</tr>
<tr>
<td>Device dr shift</td>
<td><code>-dr_value &lt;dr_value&gt;</code></td>
<td>Performs a DR shift operation.</td>
</tr>
<tr>
<td></td>
<td><code>-length &lt;data_register_length&gt;</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>-no_captured_dr_value</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>-value_in_hex</code></td>
<td></td>
</tr>
</tbody>
</table>

Central to Virtual JTAG IP core are the `device_virtual_ir_shift` and `device_virtual_dr_shift` commands. These commands perform the shift operation to each VIR/VDR and provide the address to the SLD hub for the active JTAG datapath.

(1) This argument is optional.
Each `device_virtual_ir_shift` command issues a USER1 instruction to the JTAG Instruction Register followed by a DR shift containing the VIR value provided by the `ir_value` argument prepended by address bits to target the correct SLD node instance.

**Note:** Use the `-no_captured_ir_value` argument if you do not care about shifting out the contents of the current VIR value. Enabling this argument increases the speed of the VIR shift transaction by eliminating a command cycle within the underlying transaction.

Similarly, each `device_virtual_dr_shift` command issues a USER0 instruction to the JTAG Instruction Register followed by a DR shift containing the VDR value provided by the `dr_value` argument. These commands return the underlying JTAG transactions with the `show_equivalent_device_ir_dr_shift` option set.

**Note:** The `device_virtual_ir_shift` takes the `ir_value` argument as a numeric value. The `device_virtual_dr_shift` takes the `dr_value` argument by either a binary string or a hexadecimal string. Do not use numeric values for the `device_virtual_dr_shift`.

### Running a DR Shift Operation Through a Virtual JTAG Chain

A simple DR shift operation through a virtual JTAG chain using an Altera download cable consists of the following steps:

1. Query for the Altera programming cable and select the active cable.
2. Target the desired device in the JTAG chain.
3. Obtain a device lock for exclusive communication to the device.
4. Perform a VIR shift.
5. Perform a VDR shift.
6. Release exclusive link with the device with the `device_unlock` command.
7. Close communication with the device with the `close_device` command.

### Run-Time Communication

The Virtual JTAG IP core Tcl API requires an Altera programming cable. Designs that use a custom controller to drive the JTAG chain directly must issue the correct JTAG IR/DR transactions to target the Virtual JTAG IP core instances. The address values and register length information for each Virtual JTAG IP core instance are provided in the compilation reports.

The following figure shows the compilation report for a Virtual JTAG IP core Instance. The following table describes each column in the Virtual JTAG Settings compilation report.
Table 8: Virtual JTAG Settings Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance Index</td>
<td>Instance index of the virtual JTAG IP core. Assigned at compile time.</td>
</tr>
<tr>
<td>Auto Index</td>
<td>Details whether the index was auto-assigned.</td>
</tr>
<tr>
<td>Index Re-Assigned</td>
<td>Details whether the index was user-assigned.</td>
</tr>
<tr>
<td>IR Width</td>
<td>Length of the Virtual IR register for this IP core instance; defined in the parameter editor.</td>
</tr>
<tr>
<td>Address</td>
<td>The address value assigned to the IP core by the compiler.</td>
</tr>
<tr>
<td>USER1 DR Length</td>
<td>The length of the USER1 DR register. The USER1 DR register encapsulates the VIR for all SLD nodes.</td>
</tr>
<tr>
<td>VIR Capture Instruction</td>
<td>Instruction value to capture the VIR of this IP core instance.</td>
</tr>
</tbody>
</table>

The Tcl API provides a way to return the JTAG IR/DR transactions by using the `show_equivalent_device_ir_dr_shift` argument with the `device_virtual_ir_shift` and `device_virtual_dr_shift` commands. The following examples use returned values of a virtual IR/DR shift to illustrate the format of the underlying transactions.

To use the Tcl API to query for the bit pattern in your design, use the `show_equivalent_device_ir_dr_shift` argument with the `device_virtual_ir_shift` and `device_virtual_dr_shift` commands.
Both examples are from the same design, with a single Virtual JTAG instance. The VIR length for the reference Virtual JTAG instance is configured to 3 bits in length.

**Virtual IR/DR Shift Transaction without Returning Captured IR/DR Values**

VIR shifts consist of a USER1 (0x0E) IR shift followed by a DR shift to the virtual Instruction Register. The DR Scan shift consists of the value passed by the -dr_value argument. The length and value of the DR shift is dependent on the number of SLD nodes in your design. This value consists of address bits to the SLD node instance concatenated with the desired value of the virtual Instruction Register. The addressing scheme is determined by the Quartus II software during design compilation.

The Tcl command examples below show a VIR/VDR transaction with the no_captured_value option set. The commands return the underlying JTAG shift transactions that occur.

<table>
<thead>
<tr>
<th>Virtual IR Shift with the no_captured_value Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>device_virtual_ir_shift -instance_index 0 -ir_value 1 \</td>
</tr>
<tr>
<td>-no_captured_ir_value -show_equivalent_device_ir_dr_shift</td>
</tr>
</tbody>
</table>

*Returns:*

- Info: Equivalent device ir and dr shift commands
- Info: device_ir_shift -ir_value 14
- Info: device_dr_shift -length 5 -dr_value 11 -value_in_hex

<table>
<thead>
<tr>
<th>Virtual DR Shift with the no_captured_value Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>device_virtual_dr_shift -instance_index 0 -length 8 -dr_value \</td>
</tr>
<tr>
<td>04 -value_in_hex -no_captured_dr_value \</td>
</tr>
<tr>
<td>-show_equivalent_device_ir_dr_shift</td>
</tr>
</tbody>
</table>

*Returns:*

- Info: Equivalent device ir and dr shift commands
- Info: device_ir_shift -ir_value 12
- Info: device_dr_shift -length 8 -dr_value 04 -value_in_hex

The VIR value field in the figure below is four bits long, even though the VIR length is configured to be three bits long, and shows the bit values and fields associated with the VIR/VDR scans. The Instruction Register length for all Altera FPGAs and CPLDs is 10-bits long. The USER1 value is 0x0E and USER0 value is 0x11 for all Altera FPGAs and CPLDs. The Address bits contained in the DR scan shift of a VIR scan are determined by the Quartus II software.

All USER1 DR chains must be of uniform length. The length of the VIR value field length is determined by length of the longest VIR register for all SLD nodes instantiated in the design. Because the SLD hub VIR is four bits long, the minimum length for the VIR value field for all SLD nodes in the design is at least four bits in length. The Quartus II Tcl API automatically sizes the shift transaction to the correct length. The length of the VIR register is provided in the Virtual JTAG settings compilation report. If you are driving the JTAG interface with a custom controller, you must pay attention to size of the USER1 DR chain.
Virtual IR/DR Shift Transaction that Captures Current VIR/VDR Values

The Tcl command examples below show that the no_captured_value option is not set in the Virtual IR/DR shift commands and the underlying JTAG shift commands associated with each. In the VIR shift command, the command returns two device_dr_shift commands.

**Virtual IR Shift**

```tcl
device_virtual_ir_shift -instance_index 0 -ir_value 1 \
-no_captured_ir_value -show_equivalent_device_ir_dr_shift
```

*Returns:*

- Info: Equivalent device ir and dr shift commands
- Info: device_ir_shift -ir_value 14
- Info: device_dr_shift -length 5 -dr_value 0B -value_in_hex
- Info: device_dr_shift -length 5 -dr_value 11 -value_in_hex

**Virtual DR Shift**

```tcl
device_virtual_dr_shift -instance_index 0 -length 8 -dr_value \
04 -value_in_hex -show_equivalent_device_ir_dr_shift
```

*Returns:*

- Info: Equivalent device ir and dr shift commands
- Info: device_ir_shift -ir_value 12
- Info: device_dr_shift -length 8 -dr_value 04 -value_in_hex

The figure below shows an example of VIR/VDR Shift Commands with captured IR values. DR Scan Shift 1 is the VIR_CAPTURE command, as shown in the figure below. It targets the VIR of the sld_hub. This command is an address cycle to select the active VIR chain to shift after jtag_state_cir is asserted. The HUB_FORCE_IR capture must be issued whenever you capture the VIR from a target SLD node that is different than the current active node. DR Scan Shift 1 targets the SLD hub VIR to force a captured value from Virtual JTAG instance 1 and is shown as the VIR_CAPTURE command. DR Scan Shift 2 targets the VIR of Virtual JTAG instance.
Figure 13: Equivalent Bit Pattern Shifted into Device by VIR/VDR Shift Commands with Captured IR Values

Note: If you use an embedded processor as a controller for the JTAG chain and your Virtual JTAG IP core instances, consider using the JAM Standard Test and Programming Language (STAPL). JAM STAPL is an industry-standard flow-control-based language that supports JTAG communication transactions. JAM STAPL is open source, with software downloads and source code available from the Altera website.

Related Information
- ISP & the Jam STAPL
- Embedded Programming With Jam STAPL

Reset Considerations when Using a Custom JTAG Controller

The SLD hub decodes TMS independently to determine the JTAG controller state. Under normal operation, the SLD hub mirrors all of the JTAG TAP controller states accurately. The JTAG pins (TCK, TMS, TDI, and TDO) are accessible to the core programmable logic; however, the JTAG TAP controller outputs are not visible to the core programmable logic. In addition, the hard JTAG TAP controller does not use any reset signals as inputs from the core programmable logic.

This can cause the following two situations in which control states of the SLD hub and the JTAG TAP controller are not in lock-step:
- An assertion of the device wide global reset signal (DEV_CLRn)
- An assertion of the TRST signal, if available on the device

DEV_CLRn resets the SLD hub but does not reset the hard TAP controller block. The TAP controller is meant to be decoupled from USER mode device operation to run boundary scan operations. Asserting the global reset signal does not disrupt boundary-scan test (BST) operation.

Conversely, the TRST signal, if available, resets the JTAG TAP controller but does not reset the SLD hub. The TRST signal does not route into the core programmable logic of the PLD.

To guarantee that the states of the JTAG TAP controller and the SLD hub state machine are properly synchronized, TMS should be held high for at least five clock cycles after any intentional reset of either the TAP controller or the system logic. Both the JTAG TAP controller and the sld_hub controller are guaranteed to be in the Test Logic Reset state after five clock cycles of TMS held high.
Instantiating the Virtual JTAG IP Core

To create the Virtual JTAG IP core in a Quartus II design requires the following system and software requirements:

- The Quartus II software
- An Altera download cable, such as a USB-Blaster cable

The download cable is required to communicate with the Virtual JTAG IP core from a host running the `quartus_stp` executable.

IP Catalog and Parameter Editor

The Quartus II IP Catalog (Tools > IP Catalog) and parameter editor help you easily customize and integrate IP cores into your project. You can use the IP Catalog and parameter editor to select, customize, and generate files representing your custom IP variation.

The IP Catalog automatically displays the IP cores available for your target device. Double-click any IP core name to launch the parameter editor and generate files representing your IP variation. The parameter editor prompts you to specify your IP variation name, optional ports, architecture features, and output file generation options. The parameter editor generates a top-level .qsys or .qip file representing the IP core in your project. Alternatively, you can define an IP variation without an open Quartus II project. When no project is open, select the Device Family directly in IP Catalog to filter IP cores by device.

Note: The IP Catalog is also available in Qsys (View > IP Catalog). The Qsys IP Catalog includes exclusive system interconnect, video and image processing, and other system-level IP that are not available in the Quartus II IP Catalog.

Use the following features to help you quickly locate and select an IP core:

- Filter IP Catalog to Show IP for active device family or Show IP for all device families.
- Search to locate any full or partial IP core name in IP Catalog. Click Search for Partner IP, to access partner IP information on the Altera website.
- Right-click an IP core name in IP Catalog to display details about supported devices, installation location, and links to documentation.
Note: The IP Catalog and parameter editor replace the MegaWizard™ Plug-In Manager in the Quartus II software. The Quartus II software may generate messages that refer to the MegaWizard Plug-In Manager. Substitute “IP Catalog and parameter editor” for “MegaWizard Plug-In Manager” in these messages.

Using the Parameter Editor
The parameter editor helps you to configure your IP variation ports, parameters, architecture features, and output file generation options.

- Use preset settings in the parameter editor (where provided) to instantly apply preset parameter values for specific applications.
- View port and parameter descriptions, and links to documentation.
- Generate testbench systems or example designs (where provided).
Specifying IP Core Parameters and Options

Follow these steps to specify IP core parameters and options.

1. In the IP Catalog (Tools > IP Catalog), locate and double-click the name of the IP core to customize. The parameter editor appears.

2. Specify a top-level name for your custom IP variation. This name identifies the IP core variation files in your project. If prompted, also specify the target Altera device family and output file HDL preference. Click OK.

3. Specify parameters and options for your IP variation:
   - Optionally select preset parameter values. Presets specify all initial parameter values for specific applications (where provided).
   - Specify parameters defining the IP core functionality, port configurations, and device-specific features.
   - Specify options for generation of a timing netlist, simulation model, testbench, or example design (where applicable).
   - Specify options for processing the IP core files in other EDA tools.

4. Click Finish or Generate to generate synthesis and other optional files matching your IP variation specifications. The parameter editor generates the top-level .qip or .qsys IP variation file and HDL files for synthesis and simulation. Some IP cores also simultaneously generate a testbench or example design for hardware testing.

5. To generate a simulation testbench, click Generate > Generate Testbench System. Generate Testbench System is not available for some IP cores that do not provide a simulation testbench.

6. To generate a top-level HDL example for hardware verification, click Generate > HDL Example. Generate > HDL Example is not available for some IP cores.

The top-level IP variation is added to the current Quartus II project. Click Project > Add/Remove Files in Project to manually add a .qip or .qsys file to a project. Make appropriate pin assignments to connect ports.
Files Generated for Altera IP Cores

The Quartus II software generates the following output for your IP core.

Figure 16: IP Core Generated Files

<i>Project Directory</i>
- <i>your_ip</i> - IP core variation files
  - <i>your_ip>_bb.v</i> - Verilog HDL blackbox EDA synthesis file
  - <i>your_ip>_inst.v</i> or <i>.vhd</i> - Sample instantiation template
  - <i>your_ip>_generation.rpt</i> - IP generation report
  - <i>your_ip>_bsf</i> - Block symbol schematic file
  - <i>your_ip>_syn.v</i> or <i>.vhd</i> - Sample HDL or IPFS mode
- <i>your_ip>_debuginfo</i> - Lists files for synthesis
- <i>your_ip>_synpinfo</i> - System or IP integration file
- <i>your_ip>_sopinfo</i> - Software tool-chain integration file
- <i>your_ip>_tdi.v</i> or <i>.vhd</i> - Sample testbench files
- <i>your_ip>_tb</i> - Testbench for supported simulators
  - <i>your_ip>_tb.v</i> or <i>.vhd</i> - Top-level HDL testbench file

<i>Simulation files</i>
- <i>your_ip>_syn</i> - NativeLink simulation integration file
- <i>your_ip>_v</i>, <i>.vhd</i>, <i>.vo</i>, <i>.vho</i> - Simulation HDL or IPFS mode
  - <i>your_ip>_setup_scripts</i> - Simulator setup scripts
  - <i>your_ip>_tb.v</i> or <i>.vhd</i> - Top-level IP variation synthesis file
- <i>your_ip>_tb</i> - Testbench for supported simulators

<i>Notes:</i>
1. If supported and enabled for your IP variation
2. If functional simulation models are generated

Instantiating Directly in HDL

To properly connect the Virtual JTAG IP core in your design, follow these basic connection rules:

- The <i>tck</i> output from the Virtual JTAG IP core is the clock used for shifting the data in and out on the TDI and TDO pins.
- The <i>TMS</i> output of the Virtual JTAG IP core reflects the <i>TMS</i> input to the main JTAG circuit.
- The <i>ir_in</i> output port of the Virtual JTAG IP core is the parallel output of the contents that get shifted into the virtual IR of the Virtual JTAG instance. This port is used for decoding logic to select the active virtual DR chain.

The purpose of instantiating a Virtual JTAG instance in this example is to load <i>my_counter</i> through the JTAG port using a software application built with Tcl commands and the <i>quartus_stp</i> executable. In this design, the Virtual JTAG instance is called <i>my_vji</i>. Whenever a Virtual JTAG IP core is instantiated in a
design, three logic blocks are usually needed: a decode logic block, a TDO logic block, and a Data Register block. The example below combines the Virtual JTAG instance, the decode logic, the TDO logic and the Data Register blocks.

You can use the following Verilog HDL template as a guide for instantiating and connecting various signals of the IP cores in your design.

```verilog
module counter (clock, my_counter);
input clock;
output [3:0] my_counter;
reg [3:0] my_counter;
always @ (posedge clock)
  if (load && e1dr) // decode logic: used to load the counter my_counter
    my_counter <= tmp_reg;
  else
    my_counter <= my_counter + 1;
// Signals and registers declared for VJI instance
wire tck, tdi;
reg tdo;
wire cdr, eldr, e2dr, pdr, sdr, udr, uir, cir;
wire [1:0] ir_in;

// Instantiation of VJI
my_vji VJI_INST(
  .tdo (tdo),
  .tck (tck),
  .tdi (tdi),
  .tms(),
  .ir_in(ir_in),
  .ir_out(),
  .virtual_state_cdr (cdr),
  .virtual_state_eldr (eldr),
  .virtual_state_e2dr (e2dr),
  .virtual_state_pdr (pdr),
  .virtual_state_sdr (sdr),
  .virtual_state_udr (udr),
  .virtual_state_uir (uir),
  .virtual_state_cir (cir)
);
// Declaration of data register
reg [3:0] tmp_reg;
// Decode Logic Block
// Making some decode logic from ir_in output port of VJI
wire load = ir_in[1] && ~ir_in[0];
// Bypass used to maintain the scan chain continuity for
// tdi and tdo ports
bypass_reg <= tdi;
// Data Register Block
always @ (posedge tck)
  if (load && sdr)
    tmp_reg <= {tdi, tmp_reg[3:1]};
// tdo Logic Block
always @ (tmp_reg[0] or bypass_reg)
  if(load)
    tdo <= tmp_reg[0]
  else
    tdo <= bypass_reg;
endmodule
```

The decode logic is produced by defining a wire `load` to be active high whenever the IR of the Virtual JTAG IP core is `01`. The IR scan shift is used to load the data into the IR of the Virtual JTAG IP core. The `ir_in` output port reflects the IR contents.
The Data Register logic contains a 4-bit shift register named tmp_reg. The always blocks shown for the Data Register logic also contain the decode logic consisting of the load and sdr signals. The sdr signal is the output of the Virtual JTAG IP core that is asserted high during a DR scan shift operation. The time during which the sdr output is asserted high is the time in which the data on tdi is valid. During that time period, the data is shifted into the tmp_reg shift register. Therefore, tmp_reg gets the data from the Virtual JTAG IP core on the tdi output port during a DR scan operation.

There is a 1-bit register named bypass_reg whose output is connected with tdo logic to maintain the continuity of the scan chain during idle or IR scan shift operation of the Virtual JTAG IP core. The tdo logic consists of outputs coming from tmp_reg and bypass_reg and connecting to the tdo input of the Virtual JTAG IP core. The tdo logic passes the data from tmp_reg to the Virtual JTAG IP core during DR scan shift operations.

The always block of a 4-bit counter also consists of some decode logic. This decode logic uses the load signal and eldr output signal of the Virtual JTAG IP core to load the counter with the contents of tmp_reg. The Virtual JTAG output signal eldr is asserted high during a DR scan shift operation when all the data is completely shifted into the tmp_reg and sdr has been de-asserted. In addition to sdr and eldr, there are other outputs from the Virtual JTAG IP core that are asserted high to show various states of the TAP controller and internal states of the Virtual JTAG IP core. All of these signals can be used to perform different logic operations as needed in your design.

Simulation Support

Virtual JTAG interface operations can be simulated using all Altera-supported simulators. The simulation support is for DR and IR scan shift operations. For simulation purposes, a behavioral simulation model of the IP core is provided in both VHDL and Verilog HDL in the altera_mf libraries. The I/O structure of the model is the same as the IP core.

In its implementation, the Virtual JTAG IP core connects to your design on one side and to the JTAG port through the JTAG hub on the other side. However, a simulation model connects only to your design. There is no simulation model for the JTAG circuit. Therefore, no stimuli can be provided from the JTAG ports of the device to imitate the scan shift operations of the Virtual JTAG IP core in simulation.

The scan operations in simulation are realized using the simulation model. The simulation model consists of a signal generator, a model of the SLD hub, and the Virtual JTAG model. The stimuli defined in the wizard are passed as parameters to this simulation model from the variation file. The simulation parameters are listed in the table below. The signal generator then produces the necessary signals for Virtual JTAG IP core outputs such as tck, tdi, tms, and so forth.

The model is parameterized to allow the simulation of an unlimited number of Virtual JTAG instances. The parameter sld_sim_action defines the strings used for IR and DR scan shifts. Each Virtual JTAG’s variation file passes these parameters to the Virtual JTAG component. The Virtual JTAG’s variation file can always be edited for generating different stimuli, though the preferred way to specify stimuli for DR and IR scan shifts is to use the parameter editor.

Note: To perform functional and timing simulations, you must use the altera_mf.v library located in the <Quartus II installation directory>\eda\sim_lib directory. For VHDL, you must use the altera_mf.vhd library located in the <Quartus II installation directory>\eda\sim_lib directory. The VHDL component declaration file is located in the altera_mf_components.vhd library in the <Quartus II installation directory>\eda\sim_lib directory.
### Table 9: Description of Simulation Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLD_SIM_N_SCAN</td>
<td>Specifies the number of shifts in the simulation model.</td>
</tr>
<tr>
<td>SLD_SIM_TOTAL_LENGTH</td>
<td>The total number of bits to be shifted in either an IR shift or a DR shift. This value should be equal to the sum of all the length values specified in the SLD_SIM_ACTION string.</td>
</tr>
<tr>
<td>SLD_SIM_ACTION</td>
<td>Specifies the strings used for instruction register (IR) and data register (DR) scan shifts. The string has the following format:</td>
</tr>
<tr>
<td></td>
<td><code>((time, type, value, length), (time, type, value, length), ... (time, type, value, length))</code></td>
</tr>
<tr>
<td></td>
<td>where:</td>
</tr>
<tr>
<td></td>
<td>• <strong>time</strong>—A 32-bit value in milliseconds that represents the start time of the shift relative to the completion of the previous shift.</td>
</tr>
<tr>
<td></td>
<td>• <strong>type</strong>—A 4-bit value that determines whether the shift is a DR shift or an IR shift.</td>
</tr>
<tr>
<td></td>
<td>• <strong>value</strong>—The data associated with the shift. For IR shifts, it is a 32-bit value. For DR shifts, the length is determined by <strong>length</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>length</strong>—A 32-bit value that specifies the length of the data being shifted. This value should be equal to SLD_NODE_IR_WIDTH; otherwise, the value field may be padded or truncated. 0 is invalid.</td>
</tr>
<tr>
<td></td>
<td>Entries are in hexadecimal format.</td>
</tr>
</tbody>
</table>

Simulation has the following limitations:

- Scan shifts (IR or DR) must be at least 1 ms apart in simulation time.
- Only behavioral or functional level simulation support is present for this IP core. There is no gate level or timing level simulation support.
- For behavioral simulation, the stimuli tell the signal generator model in the Virtual JTAG model to generate the sequence of signals needed to produce the necessary outputs for `tck`, `tms`, `tdi`, and so forth. You cannot provide the stimulus at the JTAG pins of the device.
- The `tck` clock period used in simulation is 10 MHz with a 50% duty cycle. In hardware, the period of the `tck` clock cycle may vary.
- In a real system, each instance of the Virtual JTAG IP core works independently. In simulation, multiple instances can work at the same time. For example, if you define a scan shift for Virtual JTAG instance number 1 to happen at 3 ms and a scan shift for Virtual JTAG instance number 2 to happen at the same time, the simulation works correctly.

If you are using the ModelSim-Altera simulator, the `altera_mf.v` and `altera_mf.vhd` libraries are provided in precompiled form with the simulator.

The inputs and outputs of the Virtual JTAG IP core during a typical IR scan shift operation are shown in the figure below.
Compiling the Design

You can instantiate a maximum of 128 instances of the Virtual JTAG IP core in a design. After compilation, each instance has a unique ID, as shown on the Virtual JTAG Settings page of the Analysis & Synthesis section of the Compilation Report, as shown in the figure below.
Figure 19: IDs of Virtual JTAG Instances

These unique IDs are necessary for Quartus II Tcl API to properly address each instance of the IP core. The addition of Virtual JTAG IP cores uses logic resources in your design. The Fitter Resource Section in the Compilation Report shows the logic resource utilization, as shown in the figure below.

Figure 20: Logic Resources Utilized
Related Information

- Design Implementation and Optimization
- Verification

Third-Party Synthesis Support

In addition to the variation file, the parameter editor creates a black box file for the Virtual JTAG IP core you created.

For example, if you create a `my_vji.v` file, a `my_vji_bb.v` file is also created. In third-party synthesis, you include this black box file with your design files to synthesize your project. A VQM file is usually produced by third-party synthesis tools. This VQM netlist and the Virtual JTAG IP core’s variation files are input to the Quartus II software for further compilation.

SLD_NODE Discovery and Enumeration

You can use a custom JTAG controller to discover transactions necessary to enumerate all Virtual JTAG IP core instances from your design at runtime. All SLD nodes and the virtual JTAG registers that they contain are targeted by two Instruction Register values, `USER0` and `USER1`, which are shown in the table below.

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Binary Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>USER0</td>
<td>00 0000 1100</td>
</tr>
<tr>
<td>USER1</td>
<td>00 0000 1110</td>
</tr>
</tbody>
</table>

The `USER1` instruction targets the virtual IR of either the `sld_hub` or a SLD node. That is, when the `USER1` instruction is issued to the device, the subsequent DR scans target a specific virtual IR chain based on an address field contained within the DR scan. The table below shows how the virtual IR, the DR target of the `USER1` instruction is interpreted.

The `VIR_VALUE` in the table below is the virtual IR value for the target SLD node. The width of this field is $m$ bits in length, where $m$ is the length of the largest VIR for all of the SLD nodes in the design. All SLD nodes with VIR lengths of fewer than $m$ bits must pad `VIR_VALUE` with zeros up to a length of $m$.

Table 11: `USER1` DR

<table>
<thead>
<tr>
<th>$m + n - 1$</th>
<th>$m$</th>
<th>$m - 1$</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDR [(n - 1).0]</td>
<td>VIR_VALUE [(m - 1).0]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The ADDR bits act as address values to signal the active SLD node that the virtual IR shift targets. ADDR is $n$ bits in length, where $n$ bits must be long enough to encode all SLD nodes within the design, as shown below.

$$n = \text{CEIL} \left( \log_2 (\text{Number of SLD_nodes} + 1) \right)$$
The SLD hub is always 0 in the address map, as shown below.

\[
\text{ADDR}\{(n-1)\ldots0\} = 0
\]

Discovery and enumeration of the SLD instances within a design requires interrogation of the sld_hub to determine the dimensions of the USER1 DR \((m \text{ and } n)\) and associating each SLD instance, specifically the Virtual JTAG IP core instances, with an address value contained within the ADDR bits of the USER1 DR.

The discovery and enumeration process consists of the following steps:

1. Interrogate the SLD hub with the HUB_INFO instruction.
2. Shift out the 32-bit HUB IP Configuration Register to determine the number of SLD nodes in the design and the dimensions of the USER1 DR.
3. Associate the Virtual JTAG instance index to an ADDR value by shifting out the 32-bit SLD node info register for each SLD node in the design.

### Issuing the HUB_INFO Instruction

The SLD hub contains the HUB IP Configuration Register and SLD_NODE_INFO register for each SLD node in the design. The HUB IP configuration register provides information needed to determine the dimensions of the USER1 DR chain.

The SLD_NODE_INFO register is used to determine the address mapping for Virtual JTAG instance in your design. This register set is shifted out by issuing the HUB_INFO instruction. Both the ADDR bits for the SLD hub and the HUB_INFO instruction is \(0 \times 0\).

Because \(m\) and \(n\) are unknown at this point, the DR register (ADDR bits + VIR_VALUE) must be filled with zeros. Shifting a sequence of 64 zeroes into the USER1 DR is sufficient to cover the most conservative case for \(m\) and \(n\).

### HUB IP Configuration Register

When the USER1 and HUB_INFO instruction sequence is issued, the USER0 instruction must be applied to enable the target register of the HUB_INFO instruction.

The HUB IP configuration register is shifted out using eight four-bit nibble scans of the DR register. Each four-bit scan must pass through the UPDATE_DR state before the next four-bit scan. The 8 scans are assembled into a 32-bit value with the definitions shown in the table below.

<table>
<thead>
<tr>
<th>Nibble7</th>
<th>Nibble6</th>
<th>Nibble5</th>
<th>Nibble4</th>
<th>Nibble3</th>
<th>Nibble2</th>
<th>Nibble1</th>
<th>Nibble0</th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>27</td>
<td>26</td>
<td>19</td>
<td>18</td>
<td>8</td>
<td>7</td>
<td>0</td>
</tr>
</tbody>
</table>

- **HUB IP version**: \(N\)
- **ALTERA_MFG_ID (0 \times 06E)**
- **m**

The dimensions of the USER1 DR chain can be determined from the SUM \((m, n)\) and \(N\) (number of nodes in the design). The equations below shows the values of \(m\) and \(n\).

\[
\begin{align*}
    n &= \text{CEIL}(\log_2(N+1)) \\
    m &= \text{SUM}(m, n) - n
\end{align*}
\]
**SLD_NODE Info Register**

When the number of SLD nodes is known, the nodes on the hub can be enumerated by repeating the 8 four-bit nibble scans, once for each Node, to yield the SLD_NODE_INFO register of each node.

The DR nibble shifts are a continuation of the HUB_INFO DR shift used to shift out the Hub IP Configuration register.

The order of the Nodes as they are shifted out determines the ADDR values for the Nodes, beginning with, for the first Node SLD_NODE_INFO shifted out, up to and including, for the last node on the hub. The tables below show the SLD_NODE_INFO register and their functional descriptions.

### Table 13: SLD_NODE_INFO Register

<table>
<thead>
<tr>
<th>31</th>
<th>27</th>
<th>26</th>
<th>19</th>
<th>18</th>
<th>8</th>
<th>7</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Version</td>
<td>NODE ID</td>
<td>NODE MFG_ID</td>
<td>NODE INST_ID</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Table 14: SLD_NODE_INFO Register Descriptions

<table>
<thead>
<tr>
<th>Field</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node Version</td>
<td>Identifies the version of the SLD node</td>
</tr>
<tr>
<td>NODE ID</td>
<td>Identifies the type of NODE IP (0x8 for the Virtual JTAG IP core)</td>
</tr>
<tr>
<td>NODE MFG_ID</td>
<td>SLD Node Manufacturer ID (0x6E for Virtual JTAG IP core)</td>
</tr>
<tr>
<td>NODE_INST_ID</td>
<td>Used to distinguish multiple instances of the same IP. Corresponds to the instance index assigned in the parameter editor.</td>
</tr>
</tbody>
</table>

You can identify each Virtual JTAG instance within the design by decoding NODE ID and NODE_INST_ID. The Virtual JTAG IP core uses a NODE ID of 8. The NODE_INST_ID corresponds to the instance index that you configured within the parameter editor. The ADDR bits for each Virtual JTAG node is then determined by matching each Virtual JTAG instance to the sequence number in which the SLD_NODE_INFO register is shifted out.

### Capturing the Virtual IR Instruction Register

In applications that contain multiple nodes, capturing the value of the VIR may require issuing an instruction to the SLD hub to target a SLD node. You can query for a VIR using the VIR_CAPTURE instruction.

Each NODE VIR register acts as a parallel hold rank register to the USER1 DR chain. The sld_hub uses the bits prepended to the VIR shift value to target the correct SLD NODE VIR register. After the SLD_state_machine asserts virtual_update_IR, the active SLD node latches VIR_VALUE of the USER1 DR register.

The figure below shows a functional model of the interaction of the USER1 DR register and the SLD node VIR. The ADDR bits target the selection muxes in the figure after the sld_hub FSM has exited the virtual_update_IR state. Upon the next USER1 DR transaction, the USER1 DR chain will latch the VIR of the last active SLD_NODE to shift out of TDO. Thus, if you need to capture the VIR of an SLD node that...
is different than the one addressed in the previous shift cycle, you must issue the \texttt{VIR\_CAPTURE} instruction. The \texttt{VIR\_CAPTURE} instruction to the sld\_hub acts as an address cycle to force an update to the muxes.

**Figure 21: Functional Model Interaction between USER1 DR CHAIN and SLD Node VIRs**

To form the \texttt{VIR\_CAPTURE} instruction, use the following instruction format:

\[
\text{VIR\_CAPTURE} = \text{ZERO} \ [ (m \ - \ 4) \ldots 0] \ ## \text{ADDR} \ [(n \ - \ 1) \ldots 0] \ ## \ 011
\]

In this format, \texttt{ZERO[]} is an array of zeros, \## is the concatenation operator, \(m\) is the width of \texttt{VIR\_VALUE}, and \(n\) is the width of the \texttt{ADDR} bit.

**AHDL Function Prototype**

The following AHDL function prototype is located in the \texttt{sld\_virtual\_jtag.inc} file in the <\texttt{Quartus II installation directory}> \texttt{\libraries\megafunctions} directory.

**Note:** Port name and order also apply to Verilog HDL.

FUNCTION sld\_virtual\_jtag(
    \texttt{ir\_out}[\texttt{sld\_ir\_width}-1..0],
    \texttt{tdo}
)
WITH{
    \texttt{lpm\_hint},
    \texttt{lpm\_type},
    \texttt{sld\_auto\_instance\_index},
    \texttt{sld\_instance\_index},
    \texttt{sld\_ir\_width},
    \texttt{sld\_sim\_action},
    \texttt{sld\_sim\_n\_scan},
    \texttt{sld\_sim\_total\_length}
}
VHDL Component Declaration

The following VHDL component declaration is located in the ALTERA_MF_COMPONENTS.vhd file located in the `<Quartus II installation directory>/libraries/vhdl/altera_mf` directory.

```vhdl
component sld_virtual_jtag
  generic (
    lpm_hint        :       string := "UNUSED";
    lpm_type        :       string := "sld_virtual_jtag";
    sld_auto_instance_index :       string := "NO";
    sld_instance_index      :       natural := 0;
    sld_ir_width    :       natural := 1;
    sld_sim_action  :       string := "UNUSED";
    sld_sim_n_scan :       natural := 0;
    sld_sim_total_length :       natural := 0
  );
  port(
    ir_in : out std_logic_vector(sld_ir_width-1 downto 0);
    ir_out: in std_logic_vector(sld_ir_width-1 downto 0);
    jtag_state_cdr :       out std_logic;
    jtag_state_cir :       out std_logic;
    jtag_state_eldr :       out std_logic;
    jtag_state_elir :       out std_logic;
    jtag_state_e2dr :       out std_logic;
    jtag_state_e2ir :       out std_logic;
    jtag_state_pdr :       out std_logic;
    jtag_state_pir :       out std_logic;
    jtag_state_rti :       out std_logic;
    jtag_state_sdr :       out std_logic;
    jtag_state_sdrs :       out std_logic;
    jtag_state_sir :       out std_logic;
    jtag_state_sirs :       out std_logic;
    jtag_state_tlr :       out std_logic;
    jtag_state_udr :       out std_logic;
    jtag_state_uir :       out std_logic;
    tck, tdi, tms, virtual_state_cdr, virtual_state_cir, virtual_state_eldr, virtual_state_e2dr, virtual_state_pdr, virtual_state_sdr, virtual_state_sdr, virtual_state_uir
  );
```

VHDL Component Declaration

Altera Corporation

Altera Virtual JTAG (altera_virtual_jtag) IP Core User Guide
jtag_state_sirs : out std_logic;
jtag_state_tlr  : out std_logic;
jtag_state_udr  : out std_logic;
jtag_state_uir  : out std_logic;
tck     : out std_logic;
tdi     : out std_logic;
tdo     : in std_logic;
tms     : out std_logic;
virtual_state_cdr       : out std_logic;
virtual_state_cir       : out std_logic;
virtual_state_e1dr      : out std_logic;
virtual_state_e2dr      : out std_logic;
virtual_state_pdr       : out std_logic;
virtual_state_sdr       : out std_logic;
virtual_state_udr       : out std_logic;
virtual_state_uir       : out std_logic
);
end component;

VHDL LIBRARY-USE Declaration

The VHDL LIBRARY-USE declaration is not required if you use the VHDL Component Declaration.

LIBRARY altera_mf;
USE altera_mf.altera_mf_components.all;

Design Example: TAP Controller State Machine

The TAP controller is a state machine with a set of control signals that routes TDI data between the Instruction Register and the bank of DR chains. It controls the start and stop of any shift transactions, and controls the data flow between the parallel hold registers and the shift registers of the Instruction Register and the Data Register. The TAP controller is controlled by the TMS pin.

The figure below shows the TAP controller state machine. The table that follows provides a description of each of the states.
Figure 22: JTAG TAP Controller State Machine

Table 15: Functional Description for the TAP Controller States

<table>
<thead>
<tr>
<th>TAP Controller State</th>
<th>Functional Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test-Logic-Reset</td>
<td>The test logic of the JTAG scan chain is disabled.</td>
</tr>
<tr>
<td>TAP Controller State</td>
<td>Functional Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Run-Test/Idle</td>
<td>This is a hold state. Once entered, the controller remains in this state as long as TMS is held low.</td>
</tr>
<tr>
<td>Select DR-Scan/Select IR Scan</td>
<td>These are temporary controller states. A decision is made here whether to enter the DR states or the IR states.</td>
</tr>
<tr>
<td>Capture DR/Capture IR</td>
<td>These states enable a parallel load of the shift registers from the hold registers on the rising edge of TCK.</td>
</tr>
<tr>
<td>Shift DR/Shift IR</td>
<td>These states enable shifting of the DR and IR chains.</td>
</tr>
<tr>
<td>Exit1 DR/Exit1 IR</td>
<td>Temporary hold states. A decision is made in these states to either advance to the Update states or the Pause states.</td>
</tr>
<tr>
<td>Pause DR/Pause IR</td>
<td>This controller state allows shifting of the Instruction Register and Data Register to be temporarily halted.</td>
</tr>
<tr>
<td>Exit2 DR/Exit2 IR</td>
<td>Temporary hold states. A decision is made in these states to advance to the Update states.</td>
</tr>
<tr>
<td>Update DR/Update IR</td>
<td>These states enable a parallel load of the hold registers from the shift registers. Update happens on the falling edge of TCK.</td>
</tr>
</tbody>
</table>

**Design Example: Modifying the DCFIFO Contents at Runtime**

This design example demonstrates the use of the Virtual JTAG IP core and a command-line script to dynamically modify the contents of a DCFIFO at runtime.

The Tcl API that ships with the Virtual JTAG IP core makes it an ideal solution for developing command-line scripts that can be used to either update data values or toggle control bits at run time. This visibility into the FPGA can help expedite debug closure during the prototyping phase of the design, especially when external equipment is not available to provide a stimulus.

This design example consists of a Quartus II project file that implements a DCFIFO and a command-line script that is used to modify the contents of the FIFO at runtime.

The RTL consists of a single instantiation of the Virtual JTAG IP core to communicate with the JTAG circuitry. Both read and write ports of the DCFIFO are clocked at 50 MHz. A SignalTap II Logic Analyzer instance taps the data output bus of the DCFIFO to read burst transactions from the DCFIFO. The following sections discuss the RTL implementation and the runtime control of the DCFIFO using the Tcl API.

**Write Logic**

The RTL uses a single instance of the Virtual JTAG IP core to decode both the instructions for the write side and read side logic. The IR register is three bits wide, with the three instructions decoded in the RTL, as shown in the table below.
Table 16: Instruction Register Values

<table>
<thead>
<tr>
<th>Instruction Register Value</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>PUSH</td>
<td>Instruction to write a single value to the write side logic of the DCFIFO.</td>
</tr>
<tr>
<td>POP</td>
<td>Instruction to read a single value from the read side logic of the DCFIFO</td>
</tr>
<tr>
<td>FLUSH</td>
<td>Instruction to perform a burst read transaction from the FIFO until empty.</td>
</tr>
</tbody>
</table>

The IR decode logic shifts the `Push_in virtual DR chain` when the PUSH instruction is on the IR port and `virtual_state_sdr` is asserted. A write enable pulse, synchronized to the `write_clock`, asserts after the `virtual_state_udr` signal goes high. The `virtual_state_udr` signal guarantees stability from the virtual DR chain. The figure below shows the write side logic for the DCFIFO.

**Figure 23: Write Side Logic for DCFIFO**

---

**Read Logic**

Two runtime instructions read the contents out of the FIFO. The IR decode logic selects the `Push_out virtual DR chain` and generates a single read pulse to the read logic when the POP instruction is active. The `Push_out DR chain` is parallel loaded upon the assertion of `virtual_state_cdr` and shifted out to TDO upon the assertion of `virtual_state_sdr`.

When the FLUSH instruction is shifted into the Virtual JTAG instance, the IR decode logic asserts the `read_req` line until the FIFO is empty. The bypass register is selected when the FLUSH instruction is active to maintain TDI-to-TDO connectivity. The figure below shows the read side logic for the DCFIFO.
Runtime Communication

The Tcl script, `dc_fifo_vji.tcl`, contains three procedures, each corresponding to one of the virtual JTAG instructions. The table below describes each of the procedures.

### Table 17: Run-Time Communication Tcl Procedures

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>push [value]</code></td>
<td>IR shift the PUSH instruction, followed by a DR shift of the value argument. Value must be an integer less than 256.</td>
</tr>
<tr>
<td><code>pop</code></td>
<td>IR shift the POP instruction, followed by a DR shift of 8 bits.</td>
</tr>
<tr>
<td><code>flushfifo</code></td>
<td>IR shift the FLUSH instruction.</td>
</tr>
</tbody>
</table>

The figure below shows runtime execution of eight values pushed into the DCFIFO and a `flushfifo` command, and a SignalTap II Logic Analyzer capture triggering on a flush operation.
Figure 25: Runtime Execution

```
C:\Virtual_JTAG\example\DC_FIFO_UJ1_restored\quartusstp -s
Info: ********************
Info: Running Quartus II SignalTap II
Info: Version 8.5 Build 215 05/29/2008 SJ Full Version
Info: Copyright © 1991-2008 Altera Corporation. All rights reserved.
Info: Your use of Altera Corporation’s design tools, logic functions
Info: and other software and tools, and its MPF partner logic
Info: functions, and any output files from any of the foregoing
Info: (including device programming or simulation files), and any
Info: associated documentation or information are expressly subject
Info: to the terms and conditions of the Altera Program License
Info: Subscription Agreement, Altera MegaCore Function License
Info: Agreement, or other applicable license agreement, including,
Info: without limitation, that your use is for the sole purpose of
Info: programming logic devices manufactured by Altera and sold by
Info: Altera or its authorized distributors. Please refer to the
Info: applicable agreement for further details.
Info: The Quartus II Shell supports all TCL commands in addition
Info: to Quartus II Tcl commands. All unrecognized commands are
Info: assumed to be external and are run using Tcl’s "exec"
Info: command.
Info: - Type "exit" to exit.
Info: - Type "help" to view a list of Quartus II Tcl packages.
Info: - Type "help <package name>" to view a list of Tcl commands
Info: available for the specified Quartus II Tcl package.
Info: - Type "help -tcl" to get an overview on Quartus II Tcl usages.
Info: ********************

tcl> source dc_fifo_uji.tcl
 tcl> push 234
 11101010
 tcl> push 235
 11101011
 tcl> push 236
 11101100
tcl> push 237
 11101110
tcl> push 238
 11110110
tcl> push 239
 11110111
tcl> push 223
 11011111
tcl> push 224
 11000000
tcl> flushfifo
```

Figure 26: SignalTap II Logic Analyzer Capture Triggering on a Flush Operation

![SignalTap II Logic Analyzer Capture Triggering on a Flush Operation](image-url)
Design Example: Offloading Hardwired Revision Information

This example demonstrates how you can use a GUI to offload revision information that is hardwired into a design. The GUI offloads the time that the design was compiled, the USERCODE from the device, and compile number that tracks the number of compile iterations that have been performed.

Because the Quartus II software ships with an installation of Tcl/Tk, you can use the Tk package to build a custom GUI to interact with your design. In many cases, the JTAG port is a convenient interface to use, since it is present in most designs for debug purposes. By leveraging Tk and the virtual JTAG interface, you perform rapid prototyping such as creating virtual front panels or creating simple software applications. The figure below shows the organization of the design.

Figure 27: Design Organization Example

A Tcl script creates and updates the verilog file containing the hardcoded version control information every time the project goes through a full compile. The Tcl script is executed automatically by adding the following assignment to the project’s .qsf file.

The USERCODE value shifted out by this design example is a user-configurable 32-bit JTAG register. This value is configured in the Quartus II software using the Device and Pin Options dialog box.

Configuring the JTAG User Code Setting

The following steps describe how to configure the JTAG User Code setting. A separate script generates the GUI and is executed with the quartus_stp command line executable. During runtime, the GUI queries the device for the version information and formats it for display within the message box.

1. On the Assignment menu, click Settings.
2. On the Settings page, in the Category list, click Device.
3. The Device dialog box appears. Click Device and Pin Options.
4. In the Device and Pin Options dialog box, on the General tab, the JTAG user code appears. Type the user code in 32-bit hexadecimal format.
5. Click OK.

Related Information
Tcl Example Scripts: Automatic Version Number
## Document Revision History

### Table 18: Document Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Changes</th>
</tr>
</thead>
</table>
| July 2014  | 2014.07.08 | • Replaced MegaWizard Plug-In Manager information with IP Catalog.  
|            |         | • Added standard information about upgrading IP cores.                  |
|            |         | • Added standard installation and licensing information.                |
|            |         | • Removed outdated device support level information. IP core            |
|            |         | device support is now available in IP Catalog and parameter editor.    |
| March 2014 | 2014.03.19 | Updated the description of the SLD_IR_WIDTH parameter in the "Parameters for the Virtual JTAG Megafuction" table. |
| February 2014 | 2014.02.25 | • Added Document Revision History table.                                |
|            |         | • Updated "Hub IP Configuration Register" figure.                      |